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Introduction
This user guide describes how to use the Meridian Administration Tools 
Common Services.

Note: Even if you have used earlier versions of MAT, you should read 
this User Guide, as MAT 6 has undergone significant improvement.

Figure 1 shows MAT components. 

Figure 1
MAT Components
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MAT Common Services provide these applications:

• using the Navigator and System windows

• defining the MAT environment, including Meridian 1 sites and system

• using the MAT scheduler

• using the system terminal

• using MAT communications services

• communicating between the MAT user and MAT applications with 
windows displaying system information

MAT users
MAT is designed for telecommunications equipment administrators with a 
working knowledge of Meridian 1 switches and general telecommunications 
concepts.

This guide assumes you are familiar with PC systems and the Microsoft 
Windows 95, Windows 98, and NT 4.0 environment. You should be familiar 
with the Windows environment before attempting to use MAT.

There are two levels of access to MAT:

• Administrator access allows unrestricted use of MAT and its function
The system administrator configures the MAT system, sets up the 
connections to the Meridian 1, and defines user access to MAT 
application modules.

• User access allows read only, read/write, or no access to sites, syst
or applications, as defined by the MAT Administrator. The 
Administrator can create a broad range of access levels for various u
P0906946 Standard April 2000
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Conventions used in this guide
This guide uses the following typographical conventions:

• User input—This font alerts you to information that you enter on your
keyboard; or, using your mouse, this font indicates buttons to click o
menu selections to make.

• Multi-lettered keys—Angle brackets denote a single multi-lettered ke
on your keyboard. For example, <Esc> denotes the Escape key, labele
Esc on PC keyboards.

• Key sequences—Keys that you press at the same time include at leas
multi-lettered key and are not separated by spaces in text. For exam
<Alt>V instructs you to press the <Alt> and V keys at the same time.

• Hot keys—You can access menu commands by using the mouse or 
keyboard. Menu items show one letter as underlined. To choose a m
item from the keyboard, hold down the <Alt> key and press the 
underlined key. For example, press <Alt>F to open the File menu.

• Windows—Refers to Microsoft Windows 95, Windows 98, and 
Windows NT Workstation V4.0.
MAT Common Services User Guide
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Configuring Sites, Systems, and Users 
This chapter provides instructions for changing the default login password 
and defining your own MAT sites, systems, and users. Only MAT 
administrators have authorization to perform these tasks. 

Changing the default login password
The default login password (Admin) should be changed immediately after 
MAT is installed to ensure security. Follow these steps if you have not 
already changed the password.

1 If MAT is not already running, follow these steps to start MAT and login 
using the default login password:

• Choose MAT from the Programs list in the Start menu.

The MAT login dialog box appears. 

• Enter the default system administrator user ID and password:

User ID: Admin

Password: Admin

Note: For security purposes, the password does not appear 
as you type it in the Password field.

• Click OK.

After MAT accepts your ID and password, the MAT Navigator 
window opens.
MAT Common Services User Guide
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2 In the Navigator window, choose Change Password from the 
Security menu to open the Change Password dialog box.

3 Enter the old password in the Old Password field.

4 Type a new password in the New Password field.

5 Retype the new password in the Confirm Password field.

6 Click OK. 

7 A message box informs you that the password was successfully 
changed. Click OK.

MAT will require the new password the next time you log on.

Site and system administration
The system administrator defines the sites and systems that appear in the 
Navigator window. Sites and systems must be defined before users can 
connect to a system and perform maintenance tasks. A site typically 
represents a physical location containing one or more systems. Systems are 
defined as Meridian 1 or Other (non-Meridian 1). Other provides access 
through VT220 Terminal Emulation such as Meridian Mail. Additional 
system types such as Meridian Passport and MSL-100 are examples of 
additional systems that can be added (refer to the appropriate user guides for 
more information). The Navigator Configuration menu allows the system 
administrator to add, change, and delete sites and systems.

Note: For more information about the Navigator and System windows, 
see “MAT Navigator and System Window” on page 41.

Figure 2
Change Password dialog
P0906946 Standard April 2000
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Adding a site
You can add any number of sites to the Navigator window. 

1 In the Navigator window, choose Add Site from the Configuration 
menu. The Site Properties window appears (Figure 3).

2 Fill in the Site Name and Short Name fields (these are required fields).

The Site Name appears in the Navigator tree. The Short Name is an 
abbreviated site name that displays in the Alarm Banner.

3 In the Site Location box, fill in the site address information.

4 In the Contact Information box, fill in the contact name and related 
information. Click Apply.

5 To add a new system to this site:

— Click Add System. 

— Follow the instructions for “Adding a system” on page 22.

Figure 3
New Site Properties sheet
MAT Common Services User Guide
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6 When you have finished entering Site information, click one of the 
following buttons to add the site to the Navigator tree:

— OK adds the site and closes the property sheet

— Apply adds the site and leaves the property sheet open allowing 
you to add another system to this site (you may repeat step 5 to 
add another system)

Cancel closes the dialog box without adding the site.

Adding a system
You can add as many systems (including non-Meridian 1 systems) to a site as 
your license permits. You must have administrator privileges to add a system.

1 In the Navigator window, select the desired site.

Note: If you are adding a new system from within the New Site 
Properties window, skip to step 3 in this procedure.

2 Choose Add System from the Configuration menu or the right mouse 
button pop-up menu.

3 In the Add System dialog box, select the type of system you want to 
add. Then click OK.

Note: You may need to install additional software to enable other 
system types not listed here. Follow the installation instructions 
included with your order.

Figure 4
Add System dialog box
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4 Click the System Properties—General tab  (Figure 5) enter the 
System Name and Short Name (required fields) and other information 
as needed. Click Apply .

You can make system location and contact information the same as 
site information by clicking the Same as Site checkbox.

Note: Bolded fields indicate required information. To change a value, 
edit the field. Some fields may have a list of predefined choices. An 
arrow within a field indicates a drop-down list of choices. Press the 
arrow to select from the list. For more detailed information, refer to the 
online help.

Figure 5
System Properties—General tab
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5 To add a new communications profile, the System 
Properties—Communications  tab. This tab defines the types of 
communications profiles that may be applied to system applications 
(one profile may be used for multiple applications).

Click Add . The Add Communications Profile dialog box appears. See 
Figure 6.  

Select a communications type from the Type box and enter a Profile 
Name, then click OK to go back to the Communications tab. See 
Figure 7. 

Figure 6
Add Communications Profile dialog box
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Figure 7
System Properties—Communications tab
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6 Fill in the communications information for the new profile:

For Ethernet: Select the appropriate network protocol. Enter the IP 
address that you configured on the Meridian 1. Click Apply.

Figure 8
System Properties—Communications tab—Ethernet Profile
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For PPP: Enter all modem parameters and dialup information. Select 
PPP in the Modem Script text box. Set the IP address to the local IP 
address, as configured on the Meridian 1. Click Apply.

Figure 9
System Properties—Communications tab—PPP Profile
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For Serial: Enter all modem parameters and dialup information. Select 
the appropriate value in the Modem Script text box. This will usually be 
“None” unless a specific value is defined for your system. Click Apply.

Figure 10
System Properties—Communications tab—Serial Profile
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7 Click the System Properties—System Data  tab (Figure 11). Enter 
the machine/system type and release version for the system and 
enable or disable M1 packages. For example, if your machine type is 
the Option 61C, enter 61C in the Machine field and enter 1 in the 
Release field.

Note: You can copy this data directly from an installed switch by 
scheduling an upload with the File  menu Update System Data  
command in the System window. Update System Data uses the 
communication profile for Station Administration. However, you should 
configure the Release number here first to allow available applications 
to show up properly in the Applications Tab.

Figure 11
System Properties—System Data tab
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8 Click the System Properties—  Applications  tab (Figure 12). 

This tab defines the MAT applications that will appear in the System 
window and the communications profile to be used with each 
application. You must enable an application for it to be available in the 
System window.

To enable an application:

• Select the application in the Applications box.
• Select a Communications Profile from the drop-down list in the 

Selected Application box.

A checkmark appears next to the application and the Enabled box is 
also checked.

To disable an application:

• Select the application in the Applications box.
• In the Selected Application box, click the Enabled checkbox to 

remove the checkmark.

Figure 12
System Properties—Applications tab
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9 Click the System Properties—Customers  tab (Figure 13).

This tab lists the customers currently defined for this Meridian 1 
system. You may add new customers, delete customers, or review the 
properties of a selected customer. When you add a new customer, you 
configure the Meridian 1 features and numbering plans that are 
available to the customer. This information it is not automatically 
updated on the Meridian 1 and must be updated by using LD15 
customer data block.

Note: Customer information is required for System 
Administration/CPND and ESN applications. 

Figure 13
System Properties—Customers tab
MAT Common Services User Guide



Page 32 of 124  Configuring Sites, Systems, and Users
10 To add a customer:

— Click Add in the System Properties—Customers tab.

— Select a Customer number. Click OK.

— Select the General tab, in the Customer Property sheet 
(Figure 14) and fill in the customer information.

Note: Enter User information in the Scheduler System ID text box if 
you are using applications with scheduled activities, such as Station 
Administration/CPND, ESN, Traffic, and Call Accounting. 

Figure 14
Customer property sheet, General tab
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• Select the Features tab (Figure 15), and fill in the customer 
information.

Figure 15
Customer property sheet, Features tab
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• Select the Numbering Plans tab (Figure 16), and fill in the 
customer information. 

• When you have finished entering customer information, click 
one of the following buttons to save the information:

—OK adds the customer and return to the System properties 
sheet.

—Apply adds the customer and leaves the Customer 
properties open so that you may add other information for 
this customer.

Cancel closes the dialog box without adding the customer.

11 To delete a customer, click Delete in the System 
Properties—Customers tab. A delete confirmation box opens. Click 
OK.

12 To modify customer information, click Properties in the System 
Properties—Customers tab. The Customer property sheet opens. 
Modify information in the appropriate tabs and click OK.

Figure 16
Customer property sheet, Numbering Plans tab
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13 In the System properties sheet, click one of the following buttons:

— Apply adds the system and leaves the dialog box open.

— OK adds the system and closes the dialog box.

— Cancel closes the dialog box without adding the system.

— Help provides online help.

The new system is added to the tree under the selected site.

Changing site information
You can change any information about a site, including the site name, 
address, and contact. You must have administrator privileges to change site 
information.

1 In the Navigator window, select the desired site.

2 Choose Properties from the File menu or the right mouse button 
pop-up menu. The Site Properties dialog box opens to the General tab.

3 Bolded fields indicate required information. To change a value, edit the 
field. Consult the online help for details on any field.

4 To add a new system to this site, click Add System, and fill in 
information for the new system. See “Adding a system” on page 22.

5 Click one of the following buttons:

— Apply saves the information and leaves the dialog box open.

— OK saves the information and closes the dialog box.

— Cancel closes the dialog box without saving.

— Help provides online help.
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Changing system information
You can change any information about a system or its communications 
connection. You must have Administrator privileges to change any system 
information.

1 In the Navigator window, select the desired system.

2 Choose Properties from the File menu or the right mouse button 
pop-up menu. 

The System Properties window opens. 

3 Select the tab containing the information you wish to change. 

Bolded fields indicate required information. To change a value, edit the 
field or select a different item from a field popup menu. An arrow within 
a field indicates a drop-down list of choices. Press the arrow to select 
from the list. Consult the online help for details on any field.

4 Click one of the following buttons:

— Apply saves the information and leaves the dialog box open.
— OK saves the information and closes the dialog box.
— Cancel closes the dialog box without saving.

— Help provides online help.

Deleting a site or system
You must have administrator privileges to delete a site or system from the 
Navigator window. A record of the deletion is stored in the PC event file.

WARNING: Deleting a site also deletes all of its systems.

1 In the Navigator window, select the site or system.

To delete all sites and systems, select the Sites icon at the top of the 
tree.

2 Choose Delete from the Edit menu.

3 Click OK to confirm.

Changing your password
You can change your password at any time. If your password has expired, 
MAT prompts you to enter a new password when you attempt to log on. Turn 
to “Changing the default login password” on page 19.
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Configuring MAT users
MAT allows you to create User Templates to speed the process of adding 
users. A template is a form that you fill in to define most aspects of a certain 
kind of user, such as their level of access to sites and systems and automatic 
connection to particular systems. You can create as many user templates as 
you need. You will assign a template to individual users when you add users 
to the MAT database.

Creating a user template

1 In the Navigator window, choose MAT Users from the Security menu 
to display the MAT Users window (Figure 17).

2 Choose Templates from the Configuration menu. The User 
Templates window appears (Figure 18).

Figure 17
MAT Users window

Figure 18
User Templates window
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3 Choose Add Template from the Configuration menu. The New 
Template property sheet appears (Figure 19). 

4 Enter a name for this class of user. 

For each site, system, and application in the tree, use the right mouse 
button popup menu to assign user privileges (Read-write, Read-only, 
or No Access). Select the Administrator box, if appropriate. The site 
and system icons change to reflect the access level.

Note: Access privileges defined for sites or systems at higher levels 
in the tree structure are applied to all subordinate items.

5 Enter values in the User ID and Password text boxes to allow this class 
of user to connect to this system without having to enter a User ID and 
Password each time you want to connect.

6 Click OK. Close the User Template window.

Figure 19
New Template property sheet
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Adding a user

1 In the MAT Users window, choose Add User from the Configuration 
menu.

The New User property sheet appears (Figure 20).

2 Enter a User ID, and from the Access Template drop-down list, select 
the template that you will use as the basis for this user definition.

3 Fill in other data as required. The window prompts you to enter a 
password and confirm it after clicking OK or Apply. 

4 Click the Change Password button to change the MAT login 
password for this user only.

5 Click OK. The new user appears in the MAT User window. Close the 
MAT User window.

Figure 20
New User property sheet
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Deleting a user template
A user template can only be deleted when all associated users of that template 
are either deleted or re-assigned to another template.

Restricting user access permission levels
A user can be restricted from having access to sites, systems and applications. 
However, when a user is defined as being restricted from any access to all 
sites, systems and applications, i.e., the Navigator, the user will, in fact, be 
able to see all the sites and systems in the Navigator tree and have read-only 
access to their properties but opening a system will only result in a System 
Window with no applications visible.

Sites and systems displayed in user templates
When adding or modifying a user template, only systems that have 
applications enabled are presented. If no applications are enabled for the 
systems within a given site, the site and system(s) will not appear in the 
Template Properties.
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MAT Navigator and System Window
The Navigator is MAT’s main window—it allows access to nearly all MA
systems and services. Navigator shows the names and types of all syste
available to the current user, and allows you to group the systems into s
for more convenient access.

Figure 21
Navigator window
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Navigator provides the following functions:

• Displays a “tree” structure for Sites and Systems on the network 
managed by the current user. Access systems at a site by opening 
site.

• Allows you to launch the System Window. See “Working with the 
System Window” on page 83.

• Allows you to configure and administer MAT data: Sites and System
Users, and so on

• Allows you to configure and administer MAT Services, such as 
Integrated Telephony Gateway

• Allows you to launch utility applications such as the Scheduler, 
Corporate Directory, and Alarm Notification

• Allows you to display the licensing and release information for all 
installed MAT applications

• Allows you to print reports
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Figure 22 illustrates these functions.

Figure 22
Navigator functions
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Using Navigator 
Navigator allows you to access any Meridian 1 system or other systems 
which your user ID privileges allows you to. In Navigator, you open the site 
of interest to choose a system on which to work. Double-click a system to 
open its System window and launch any of the MAT 6 applications to work 
on that system. 

Open a site by double-clicking its name or clicking the “+” symbol next to t
site. The “+” changes to a “-” when the site opens. An open site displays
systems at that site. Close a site by clicking the “-” symbol.

For Meridian 1 systems, the components that make up the system appe
the system window. MAT 6 displays a terminal emulation window for 
systems defined as “Other.”
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Logging in and launching the Navigator
Select MAT in the Windows Programs list. The login dialog appears (see 
Figure 23). Enter your User ID and password. The Navigator window appears 
as shown in Figure 24.  

Figure 23
Login dialog box

Figure 24
Navigator window
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Navigator menus
Detailed descriptions about the functions of each command in the Navigator 
menus are available by clicking the “Context-sensitive Help” button in th
toolbar. Navigator menus consist of:

• File

• Edit

• View

• Maintenance

• Configuration

• Security

• Utilities

• Window

• Help

Services Folder
The services folder contains applications and services available for sites and 
systems defined and accessible by the MAT PC. 

MAT IP Telephony Gateway Applications
The following applications provide configuration and maintenance for the 
ITG card.

• ITG M1 IP Trunks

This application configures and maintains the 8-port ITG (trunk) card
that resides in the IPE shelf of a Meridian (M1) system. The card ha
10/100 baseT connection to carry pocket-sized voice and fax calls o
IP data networks, and can serve as a toll bypass to the traditional PS
For more information refer to Meridian Internet Telephony Gateway 
(ITG) Trunk 1.0/Basic Per-Trunk Signaling (553-3001-116).
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• ITG ISDN IP Trunks

This application configures and maintains the 24-port ITG (trunk) ca
that resides in the IPE shelf of the Meridian 1 (M1) or Multi-Media 
Carrier Switch (MMCS). The card appears to the switch as a 24-por
trunk card with ISDN Signaling Link (ISL) and D-channel signaling. Th
card has a 10/100 baseT connection to carry packetized voice and f
calls over IP data networks. For more information refer to Meridian 
Internet Telephony Gateway (ITG) Trunk 2.0/ISDN Signaling Link (ISL) 
(553-3001-202).

• ITG IP Telecommuter

This application provides the configuration and maintenance of the I
line card for IP Telecommuter. This application configures the IP Lin
gateway and the gatekeeper, but not the H.323 IP terminal or PC-ba
software client. For more information refer to Meridian Internet 
Telephony Gateway (ITG) Line 1.0/IP Telecommuter (553-3001-119).

• ITG IP Phones 

This application provides the configuration and maintenance of the I
gateway card for the Meridian Internet Telephone, also referred to as
i2004 set. The i2004 set is a true Internet telephone when connected
Meridian 1 through an IPE-to-ITG gateway card. The configuration o
i2004 is through the Station Admin application in MAT. For more 
information refer to Meridian Internet Telephony Gateway (ITG) Line 
2.0/i2004 Internet Telephone (553-3001-204).
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Toolbar
The Navigator toolbar includes several buttons that act as shortcuts to the 
commands available in the menus. The function of each button in the toolbar 
appears when you move the mouse over the button. See Figure 25.

Status Bar
A Status Bar is located at the bottom of the window. To display or hide the 
Status Bar, use the Status Bar command in the View menu. 

The Status Bar describes actions of the menu commands as you use the mouse 
to navigate through menus. It also describes the actions of the Toolbar buttons 
as you press them. When you choose a menu command, the Status Bar 
describes the progress of the command while it executes. For example, the 
Status Bar shows Printing text when you choose Print from the File menu.

Figure 25
Navigator Toolbar
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Using MAT Scheduler
Scheduler allows you to set up predefined tasks and schedule them to run at 
specific dates and times. Such tasks as system updates or data collection can 
be set up once for multiple execution.

A task is a specific activity that MAT 6 can perform, such as updating the 
system, generating a report, or collecting data. Note that only jobs can be 
scheduled; individual tasks cannot. A job may contain a single task or 
multiple tasks.

With job scheduling, you can request that one or more activities be performed 
once or on a recurring basis. When a scheduled job runs, it executes its 
component tasks in the sequence you specify. The Scheduler then sends these 
tasks to the Queue Manager at the specified time. If multiple tasks are in the 
same queue, the Queue Manager attempts to run them in queue sequence. 
You can access the Queue Manager to review and change the priority of task 
execution.

Accessing Scheduler
You can either directly access the Scheduler from a supported application, 
such as Station Administration, or you can access the Scheduler from the 
MAT Navigator and then create a job and its component tasks.

Access the Scheduler from a supported application by selecting the Schedule 
command where it appears. This is the more common method of running a 
scheduled job since most required tasks are run from a particular application 
(e.g., data collection in Call Accounting and Traffic Analysis).
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Access the Scheduler directly from Navigator by clicking Scheduler from 
the Utilities drop-down menu. This may be necessary if no jobs have been 
previously scheduled in MAT and you wish to create or edit a scheduled job 
without running any supported applications.

Once you access the Scheduler, the following window will appear.

How the Scheduler works
The Scheduler reads job data and builds a list of tasks and their schedule 
information in memory. Every minute, the Scheduler compares the current 
time with the scheduled time of each entry in the task list. When the times 
match, the tasks are executed sequentially, allowing one task to complete 
before the next task begins. If you close the Scheduler, the task list is 
lost—the task list is rebuilt the next time you run the Scheduler.

Jobs and tasks
The MAT Scheduler is used to execute activities (jobs) at scheduled date
times. Each job consists of at least one task (or set of tasks) which can 
be scheduled to run at a specific time. A task is a specific activity which 
MAT system will execute as part of the job.

Only jobs can be scheduled; tasks cannot be scheduled separately. Whe
job runs, it executes its component tasks as they are listed in the Task L
the Job Properties dialog. In most cases, each job will only contain one 

Figure 26
Scheduler window
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If a job contains multiple tasks, each task will be sent to the queue one after 
the other once the job starts. The Scheduler will send these tasks to the Queue 
Manager at the time of execution and run the Queue Manager accordingly.

If multiple tasks are waiting in a queue to run at the same time, the Queue 
Manager will attempt to execute each task sequentially as it appears in its 
queue.

Job Summary Display
As each job is configured and added to the Scheduler, it will be displayed in 
its main window. The main Scheduler window contains this list of jobs in this 
Job Summary Display grid.

You can use the cursor commands to resize and move each column in this grid 
as required. This Job Summary Display lists all of the configured jobs and 
their basic information. From this display grid, you can scan through each job 
and select it for editing.

The Job Summary Display grid lists the following information for each 
configured job:

• Scheduled

• Job

• Interval

Configuring and scheduling a job
Once you access the MAT Scheduler, you can begin to schedule its jobs and 
add tasks to it. Use the Scheduler editor commands to create and update jobs 
throughout your session.

The first step in setting up a job is to select a job and assign a single task or 
group of tasks to this job. You can select an existing job to edit or create a new 
job.

Once you have assigned the tasks to the job, you must specify the date and 
time at which the job will be run as well as any intervals for subsequent 
executions of the job.
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If you are creating a new job from another MAT application, that is if you are 
scheduling an activity from that application, then the system will directly 
access the Job Properties dialog. From this dialog, you can enter the job
general information, its individual tasks and its scheduled date and time

To create a new job directly from the Scheduler, click Add Job from the 
Configuration drop-down menu. Again, this will access the Job Propertie
dialog from which you can enter this job’s information.

To edit an existing job, click once on the job record line in the Job Summ
Display to highlight it and click Properties from the File drop-down menu 
(or simply double-click on the job record line). Again, this will access the J
Properties dialog from which you can edit this job’s information.

Once you have accessed the Job Properties dialog, enter the job’s inform
by selecting the following tabs:

• General

• Task

• Schedule

Once you have entered the job’s details, tasks and scheduling informati
click OK to save it and exit to the Scheduler main window.

If you accessed this function from the Scheduler main window, then clos
the Job Configuration dialog will return you to the main window.

If you scheduled a job from a task command dialog (from another 
application), then this will return you to that application. The job will then 
executed at its scheduled time.

Example job configuration
The following example highlights the main steps involved in configuring a
scheduling a job which is invoked from another MAT application.

Scenario
A user wishes to schedule a data collection from MAT Call Accounting da
at 5:00 p.m. The initial data collection will be run on the current day which
03/22/96.
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Steps to scheduling a job

1 Open a system and access Call Accounting. From Call Accounting, 
click Communications and click Schedule Data Collection from its 
drop-down menu. Since you are creating a new task, you must either 
create a new job to which this task belongs or add the task to an 
existing job. Remember that an activity such as data collection is a task 
which is associated with a job. You cannot schedule a task; only a job.

2 When you click Schedule Data Collection from Call Accounting, the 
Add Task for Scheduling dialog will appear prompting you to either add 
this task to an existing job or create a job and add the task to the new 
job.

Note: For this example, you will create a new job. Therefore, click 
Add New Job from this dialog. This will access the Scheduler Job 
Properties dialog.

3 In the Job Properties General tab fields, enter the following:

Name: Data Collection (used for informational purposes)

Queue: Data Collection (used by the Queue Manager to create a 
queue by this name)

4 Click the Task tab to review the tasks which are added to this job. 
Notice that the Data Collection command is the only task in this list.

5 Click the Schedule tab to enter the scheduling criteria for this job. In 
the Schedule fields, enter the following:

Interval: Daily

Start at:Month:  03Day:  22Year:  96

Hour:  5Minute:  00am/pm:  pm

6 Click OK to save this configuration. Notice that the Job Summary 
Display grid will appear with this job added to it.

This completes the example job configuration. This job will then be run at the 
scheduled time. Ensure that the Scheduler is running at the scheduled time so 
it can run the job.
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Device contention
The Queue Manager contains certain restrictions when managing multiple 
queues for a single device. This applies when multiple jobs are sent by the 
Scheduler to the Queue Manager for execution and therefore have multiple 
queues stored in the Queue Manager database. A job is a group of tasks which 
is sent to the Queue Manager as a queue. If these queues attempt to access the 
same device (e.g., COM port) at the same time, then only one queue will be 
able to use it successfully. All other queues will NOT be able to access that 
device and will therefore not run.

The following example helps demonstrate this contention.

Example for device contention
The following jobs have all been scheduled to run daily at 12:00pm. They will 
all invoke separate queues which will attempt to use COM 2 on the MAT PC.

• Call Accounting data collection

• Call Tracking real time access

• Traffic Analysis data collection

At 12:00pm, each of these jobs will be sent to its own queue in the Queue 
Manager which will then attempt to access COM 2. Since they will all attempt 
to access COM 2 at the same time, COM 2 appears to be available to each of 
them. Each queue will then run a task. However, COM 2 will ONLY be 
available to the first task which executes. Since the remaining tasks cannot 
access COM 2, they will not execute.

Late execution
This device contention issue also applies to queues which have Late 
Execution enabled. If the MAT system is shut down and starts up again, any 
jobs which have Late Execution enabled (and their scheduled times have 
elapsed) will attempt to run immediately. If these jobs attempt to access a 
single device at this time, then only the first task will be able to access it. All 
others will fail.

To prevent this contention problem from occurring for jobs with late 
execution, you should use caution when enabling this option. Ensure that only 
the required jobs have this option enabled or verify that they will not access 
the same device during a system shut down and start up.
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Solution
To prevent this from occurring during normal system operation, use the 
following guidelines.

• If you need to schedule multiple jobs for a single device all at the sa
time, or if you cannot schedule the jobs so that you are sure that the
device will be released in time, then schedule the jobs as multiple ta
sent to a single queue. The Queue Manager can then manage these
in the single queue and send them to the device as each task is comp
Each task in the queue will wait for the previous task to release the de
before attempting to access it. This way, you will ensure that all of th
tasks will be able to access the device and execute successfully.

• This is a recommended solution since it allows the Queue Manager
manage the tasks for a single device allowing each task to use the de
as it becomes available.

If you need to schedule jobs at different times and they all require a sin
device, ensure that these jobs are scheduled to run at times far eno
apart to allow the device to be released by a queue before the next j
scheduled to run. Also ensure that the Late Execution option is disab
for each job in case of a system shut down and start up.

Scheduler menus
Detailed descriptions about the functions of each command in the Scheduler 
menus are available by clicking the “Help” button in the Scheduler menu b
Scheduler menus consist of:

• File

• Edit

• Maintenance

• Configuration

• Help
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Queue Manager
The MAT Queue Manager is used to store and execute the scheduled jobs as 
defined in the MAT Scheduler. Queue Manager ensures that a sequence of 
tasks are performed in a specific order, allowing each task to run to 
completion in a designated order before executing the next (e.g., ensuring that 
a traffic data collection is run before a traffic data parse).

When a job is scheduled, the Scheduler sends all tasks associated with that job 
to the Queue Manager for assignment to a specific queue for handling.

The Queue Manager is also useful in situations where a non-shareable facility 
is required, such as a communications port. A communications port may 
serve a number of communications scripts which cannot all run 
simultaneously. The Queue Manager allows the system to manage multiple 
requests through a single queue model.

The Queue Manager contains a number of individual queues. Each queue is 
responsible for a job, although multiple jobs may share a single queue.

The Queue Manager is responsible for placing jobs and tasks into the correct 
queue for handling. Although there is only one Queue Manager, there may be 
a number of active queues. Each queue executes its own tasks sequentially, 
but all queues operate independently.
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Accessing Queue Manager
To access the Queue Manager directly from the MAT Navigator, click Queue 
from the Utilities drop-down menu of the MAT Navigator window. The 
Queue Manager window will appear with all of the configured queues listed 
in its main window—the Queue Summary Display. Once you have acces
the Queue Manager, you can use it to create and edit its configured que

The Queue Manager window is shown in Figure 27. 

The Queue Manager window lists all of the configured queues and their b
information. From this display, you can scan through each queue and sel
for editing.

Figure 27
Queue Manager window
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Configuring a queue
Once you have created and added a queue to the Queue Manager using the 
Scheduler, you can access it again to edit its properties or add tasks to it as 
required.

To edit a queue, either double-click on the queue record in the Queue 
Summary Display grid or click once on the queue record and click Properties 
from the File drop-down menu. Edit this queue by selecting from the 
following tabs in this dialog:

• General

• Tasks

Once you have entered the information for each queue, click OK to save it and 
exit to the Queue Manager main window.
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Using Corporate Directory
MAT’s Corporate Directory is a flexible tool for defining and generating 
reports of station data associated with terminal number. Report data is 
provided by MAT Station Administration. Data can include about 100 
different data fields, including the name, extension, location, and departm
associated with each terminal number.

Note: Corporate Directory requires that you have MAT Station 
Administration and Microsoft Excel 95 or later currently installed. 

Defining and generating reports
Select Corporate Directory from the Utilities menu of the Navigator 
window. This opens the Corporate Directory window, where you can vie
and manage reports. You can use predefined reports or define new repo

To define a report, select Add Report from the Configuration menu. This 
displays the New Report property sheet where you can define data field
column names, column order, and directory location for the report.

To generate a report, select Generate Report from the File menu. Select Now 
to immediately display the report in a Microsoft Excel window, print the 
report, or save it to a file. Select Schedule to have the report automatically 
generated to a printer or Excel file at a later time. Select a report by name,
select Open to display the most recently generated version of that report.

Note: Before you can generate reports, Station Administration data must 
be downloaded from the switch and you must have at least one customer 
configured for each system.

See “Generating Reports” in the Station Administration User Guide for more 
information.
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Using Data Buffering and Access
The MAT Data Buffering and Access (DBA) application simplifies the 
process of collecting buffered Meridian 1 data to a PC. DBA’s M1 Datab
Disaster Recovery feature also allows for simple backup and restoring o
Meridian 1 database files.

In case of lost connections or other problems, a Meridian 1 system buffe
Call Detail Records (CDR) and Traffic data for retrieval once the connect
is restored.

Note: DBA is not supported on Option 11C Compact systems, but may 
be supported in a later software release.

DBA provides a Windows interface to perform the following:

• Configuration and monitoring of live data buffering sessions

• Retrieval of buffered data from a Meridian 1 system to a PC

• M1 Database Disaster Recovery (backup and restore)

DBA schedules:

• Retrieval of buffered data from a Meridian 1 system to a PC

• M1 Database Disaster Recovery (backup only)

Note: DBA currently supports CDR and Traffic data.
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Launching DBA
To launch DBA from MAT, select Utilities - Data Buffering and Access in 
the MAT Navigator window.

The DBA main window will appear. (See Figure 28.)

Figure 28
DBA main window
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DBA main window menus
DBA’s main window menus consist of the following:

• File

— New Session...: Open and configure a new session window for a
new live data session with a Meridian 1 system.

— Schedule...: Schedule a Meridian 1 database backup and/or 
CDR/Traffic data retrieval for Option 11C systems.

— Properties...: Display the configuration for the selected window.

— Connect Now: Establish a live data session with a Meridian 1 
system. (Only enabled when not connected to the system.)

— M1 Database Disaster Recovery...: Display the M1 Database 
Disaster Recovery dialog.

— Exit: Close the DBA main window and all session windows.

• Edit

— Copy: Place a copy of the selected item(s) on the Clipboard.

— Select All: Select all text in the window.

— Find...: Find a particular string in the displayed text data.

• View

— Toolbar: Display or hide the Toolbar.

— Status Bar: Display or hide the status bar.

— Statistics: Display the average number of CDRs per minute and t
time of the last Traffic sample.

— CDR Data: Display a snapshot of the CDR data collected so far, 
to the last 15 minutes.

— Traffic Data: Display a snapshot of the Traffic data collected so fa
up to the last 15 minutes.

— Refresh: Refresh the CDR/Traffic data display with the latest da

— Tray Icon: Display or hide the DBA icon on the Windows icon tra

— Hide Application: Hide the DBA main window.
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• Window

— Cascade: Arrange the session windows in an overlapping patter

— Tile Vertically: Arrange the session windows from left to right.

— Tile Horizontally: Arrange the session windows from top to bottom

— Arrange Icons: Arrange the icons of the minimized session 
windows.

• Help

— Help Topics: Display the online help window.

— About Data Buffering and Access...: Displays release information 
Data Buffering and Access application.

Note: Some menus and commands will not be visible or accessible 
unless a live data session is in progress. See “Starting a new live da
session” on page 65.

Toolbar
The DBA Toolbar provides easy access to many of the menu commands.

A popup menu containing a subset of the menu items is also available by 
right-clicking the mouse in the session window.

Figure 29
DBA Toolbar
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Starting a new live data session
To collect live data, you must start and configure a live data session, an active 
connection to a Meridian 1 system. The DBA application runs continuously 
during the session, providing access for session configuration and a window 
for monitoring session information. Special operations, such as Meridian 1 
database backup, can be run immediately or scheduled to occur within a 
session.

Note: The Meridian 1 system must be configured from your MAT 
Navigator. (See “Adding a system” on page 22.)

1 Select File - New Session in the DBA main window.

The Select an M1 System for Live Data dialog box opens. (See 
Figure 30.)

Figure 30
Select an M1 System for Live Data dialog box
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2 Use the dialog box tree to select the M1 system for the session.

3 Click OK, or double-click on the selected system, to confirm your 
selection.

The Session Properties dialog box opens. (See Figure 31.) 

4 If you wish to change your system selection, click on Change to return 
to the last dialog box.

5 (Optional) Enter the Host Name and IP Address of the system and 
your User ID and Password in the indicated fields.

Note: The Host Name, IP Address, User ID, and Password fields 
are configured for the Meridian 1 system in MAT Navigator. (See 
“Adding a system” on page 22.) Any changes made from this dialog 
box are temporary and will be lost when the session window closes.

6 Check the Data Type boxes to select which types of data 
(CDR and/or Traffic) DBA will buffer.

WARNING: Data types selected will be configured on the Meridian 1 
system. If a data type is not selected for buffering, collection of that 
data type on the Meridian 1 system will be turned off.

Figure 31
Session Properties dialog box
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7 (Optional) Select the MAT data folder in which buffered data will be 
stored:

• Common Data - Data will be stored in the Common Data 
folder.

• Local Data - Data will be stored in the Local Data folder.

The recommended default setting is the Common Data folder, where 
other MAT data is stored. If you select Local Data a dialog box will 
appear, asking you to confirm this. Click Yes to confirm.

8 Select Connect Now to connect with the selected M1 system and 
begin your live data session.

Note: If you do not choose to buffer either or both data types, dialog 
boxes will appear asking you to confirm this. 

A new child window opens in your DBA main window. The host name of the 
connected M1 system appears on the title bar. DBA uses this session window 
to provide information on the live data session. (See “Viewing data” on 
page 71.)

Leave the session window open to maintain your live data session. Clos
the window terminates the live data session. If the session is terminated
Meridian 1 system will begin buffering data to:

• Hard drive (large systems)

Note: This is not recommended for large systems.

• Flash ROM (Option 11C)
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Configuring an existing live data session
A live data session can be reconfigured as needed.

1 Select the window corresponding to the live data session to be 
reconfigured.

2 Select File - Schedule.

The Session Properties dialog box opens. (See Figure 31.)

3 If you wish to change your system selection, click on Change to return 
to the last dialog box.

4 (Optional) Enter the Host Name and IP Address of the system and 
your User ID and Password in the indicated fields.

Note: The Host Name, IP Address, User ID, and Password fields 
are configured for the Meridian 1 system in MAT Navigator. (See 
“Adding a system” on page 22.) Any changes made from this dialog 
box are temporary and will be lost when the session window closes.

5 Check the Data Type boxes to select which types of data 
(CDR and/or Traffic) DBA will buffer.

WARNING: Data types selected will be configured on the Meridian 1 
system. If a data type is not selected for buffering, collection of that 
data type on the Meridian 1 system will be turned off.

6 (Optional) Select the MAT data folder in which buffered data will be 
stored:

• Common Data - Data will be stored in the Common Data 
folder.

• Local Data - Data will be stored in your Local Data folder.

The recommended default setting is the Common Data folder, where 
other MAT data is stored. If you select Local Data a dialog box will 
appear, asking you to confirm this. Click Yes to confirm.

7 Select Connect Now to reconfigure the live data session with the new 
settings.

Note: If you choose not to buffer either or both data types, dialog 
boxes will appear asking you to confirm this. Click Yes to confirm.
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Scheduling operations.
DBA allows you to schedule single or routine backups of your Meridian 1 
database files. On an Option 11C system, you can also schedule the retrieval 
of buffered CDR and Traffic data from the Meridian 1 system to the PC.

The following procedure details how to schedule either operation in DBA.

Note: A scheduled job does not configure the M1. The correct LD 117 
settings (DBK and BUF) must be set on the M1.

1 Select File - Properties... in the DBA main window.

The Select an M1 System for Scheduling dialog box opens. (Similar to 
Figure 30)

2 Use the dialog box tree to select the M1 system to be scheduled.

3 Click OK, or double-click on the selected system, to confirm your 
selection.

The Scheduled Job Properties dialog box opens. (See Figure 32.)

4 If you wish to change your system selection, click on Change to return 
to the last dialog box.

Figure 32
Scheduled Job Properties dialog box
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5 (Optional) Enter the Host Name of the System in the indicated field.

Note: The Host Name, IP Address, User ID, and Password fields 
are configured for the Meridian 1 system in MAT Navigator. (See 
“Adding a system” on page 22.) You can only change the Host Name 
from this dialog box. Any changes made to the Host Name are 
temporary and will be lost when the session window closes.

6 Click on the checkbox of the operation you want to schedule:

• M1 Database B ackup - backup Meridian 1 database files.

• Data Retrieval  - retrieve buffered CDR and Traffic data from 
the Meridian 1 system.

Note: The Data Retrieval checkbox will only function on an Option 
11C system.

7 (Optional) Select the MAT Data Folder in which buffered data is stored:

• Common Data - Data will be stored in the Common Data 
folder.

• Local Data - Data will be stored in the Local Data folder.

The recommended default setting is the Common Data folder, where 
other MAT data is stored. If you select Local Data a dialog box will 
appear, asking you to confirm this. Click Yes to confirm.

8 Click OK to confirm your settings and proceed.

The MAT Scheduling dialog box opens.

9 Use the MAT Scheduling dialog box to schedule the operation.

(See “Using MAT Scheduler” on page 49.)
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Viewing data
In a live session, you can view the CDR and Traffic data being collected, as 
well as session data collection statistics. (See Figure 33.)

Select View - CDR Data to have the session window display a snapshot of 
CDR data collected by DBA, up to the last fifteen minutes.

Select View - TRF Data to have the session window display a snapshot of 
Traffic data collected by DBA, up to the last fifteen minutes.

Select View - Statistics to have the session window display the average 
number of CDRs per minute and the time of the last Traffic Sample.

Select View - Refresh to update CDR and Traffic data with the latest 
collected data.

You can use the following menu commands to manipulate text in the session 
window.

Use Edit - Copy to copy text from the session window.

Use Edit - Select All to select all text in the session window.

Use Edit - Find to locate selected text in the session window.

Figure 33
Sample session window displaying Statistics
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M1 Database Disaster Recovery
M1 Database Disaster Recovery provides a quick way to perform Meridian 1 
database backups and restores, or to schedule database backups. You can 
schedule or manually start a backup operation, and the application connects 
to the switch and retrieves the database files. An administrator can also 
manually start a restore operation to restore the database file to the PBX.

Note: M1 Database Disaster Recovery supplements the regular 
Meridian 1 database backup feature: Electronic Data Dump (EDD).

1 Open and select a session window.

2 Select File - M1 Database Disaster Recovery.

The M1 Database Disaster Recovery dialog box opens. (See 
Figure 34.)

Figure 34
M1 Database Disaster Recovery dialog box
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3 Click on one of the two radio buttons to select an operation:

• Backup  - backup Meridian 1 database files to the PC.

Note: Backups can be performed on a PC other than the one used for 
collecting live CDR and/or Traffic data.

• Restore  - transfer previously backed up Meridian 1 database 
files from the PC to the Meridian 1 system.

WARNING: The Restore  operation will overwrite the existing 
database files on the Meridian 1 system. Before using Restore :

• Make sure that your backup files are valid.

• Make sure that no other PC is performing a Backup or 
Restore.

4 Select one of the following buttons to proceed:

• Run Now to begin selected operation

• Schedule to specify a time for routine database backup 
(Restore cannot be scheduled.) The MAT Scheduling dialog 
box will open. Use the dialog box to schedule your database 
backup.

(See “Using MAT Scheduler” on page 49.)
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Hiding and restoring your DBA main window
Since maintaining a live data session requires keeping the DBA main window 
continuously open for long periods of time, you can minimize screen clutter 
by hiding the DBA main window, making it vanish from the Windows 
Desktop, whenever you do not need it. While the main window is hidden, 
DBA will still be active and the DBA tray icon will continue to appear on the 
Windows Toolbar.

To hide your DBA main window, either:

• Select View - Hide Application.

• Click on the toolbar Hide Main Window button.

• Or double-click on the DBA tray icon.

To restore your DBA main window, double-click on the tray icon.

You can also right-click on the tray icon to display a popup menu. Depending 
on whether the DBA main window is hidden or not, you will see either the 
menu item Hide Window or Restore Window. You can use these commands 
to hide or restore your DBA main window. You can also select Exit to end the 
program.
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Using Backup and Restore
MAT’s Backup and Restore utilities provide convenient options for 
safeguarding, cloning, and restoring MAT data on a PC. The Backup uti
lets you create a MAT 6 backup file of PC-based system property and 
application data for any or all sites and systems. The Restore utility lets 
restore a backup file to the same or different sites and systems on the sa
other PCs.

Note: The Backup and Restore utilities have no affect on Meridian 1 
data. To secure MAT data that has been uploaded to the switch, you must 
use MAT’s Electronic Data Dump feature described on page 87.

Media, files, and data types
You can create a MAT backup file on the PC’s hard drive, a network driv
diskettes and other removable disks, or any other available media that m
your requirements for convenience and file space.

All backup data is written to a single folder for each backup operation. T
folder includes the following files:

• Zip file (*.ZIP), the backup file in compressed format

• Log file (*.LOG), providing the backup file’s date; type; MAT version
and sites, systems, and applications by name

You can back up and restore data for all or any combination of the following 
MAT applications:

• Call Accounting

• Call Tracking

• ESN
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• Station Administration

• Traffic Analysis

You can back up and restore data for these MAT applications across multiple 
sites and systems at the same time.

Applications are associated with specific sites and systems. All backups of 
application data include the system property data associated with the selected 
site or system.

When you restore data from a backup file, you have the option not to restore 
system property data. This option is useful in cases where the destination site 
or system is pre-configured and you do not want to overwrite its system 
property data. For example, system property data such as communication 
ports, modem configuration, and user ID and password, may be different 
from one PC to the next.

Benefits
The Backup and Restore utilities provide several key benefits:

• cloning

• moving data offsite

• disaster recovery

Cloning
The process of copying system property and application data associated with 
one site or system to another site or system is called cloning. Copying data to 
another site or system can be a great timesaver. It can save you from having 
to enter a large amount of similar data one item at a time.

After cloning selected data, you can simply focus on making whatever 
changes are necessary to the cloned data. This operation is very flexible. The 
destination site or system can be new or already exist, and it can be on the 
same PC or on another PC.
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Note: If you back up data from one PC and restore it to another, you 
must perform this operation under the same version of MAT. You cannot 
back up data from a PC with an older version of MAT and then restore 
the data to a PC with MAT 6. Upgrade the older version of MAT before 
performing this type of cloning operation.

Moving data offsite
If you want to maintain or occasionally modify MAT data offsite, a MAT 
backup file provides the solution. You can restore the backup file on any PC 
that has the same version of MAT installed.

When you finish modifying MAT data, create a new backup file. Then you 
can restore the modified data to the original or primary PC where MAT is 
installed.

Note: This operation works particularly well for modifying application 
data. Remember not to restore system property data from one PC to 
another if the PCs need to have different configurations for the 
corresponding sites and systems.

Disaster recovery
An important part of safeguarding your MAT data is having a disaster 
recovery plan. This plan should consider who makes the backups, what is 
backed up, how often, on what media, and where the backups are stored.

The Backup utility includes a more comprehensive backup option that is 
designed for disaster recovery. This option automatically backs up all sites, 
systems, and applications, and additionally saves user-created files such as 
scripts and customized reports. Consider performing this type of backup at 
least once a month and storing the backup file in a safe place.

In the event of unrecoverable data loss, restore your disaster-recovery backup 
file first. All file contents are restored to the PC. Then, if you have backups 
for selected sites, systems, and applications that are more recent, restore them 
next.

Note: MAT executables and files that can be reinstalled from the MAT 
CD are excluded in a disaster recovery backup. If MAT executables have 
been damaged or lost due to a hard-disk crash, for example, you will need 
to reinstall MAT on your repaired or replaced PC before restoring your 
disaster recovery backup.
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Running the Backup utility
Select Backup from the Utilities menu of the Navigator window. This 
invokes a wizard to help you define the following parameters:

• Type of backup (single site, single system, all sites and systems, or
disaster recovery)

• Applications (Call Accounting, Call Tracking, ESN, Station, and/or 
Traffic)

• Destination directory for backup files

• Temporary directory for working files created during the operation

Note: The destination and temporary directory screens display a 
computed space requirement for the files. You can back up and restore 
data for these MAT applications across multiple sites and systems at 
the same time.

The next screen to appear is a dialog box (Figure 35) that summarizes your 
choices. Click OK to start the backup operation, or Cancel to return to the 
wizard and change your options.

Running the Restore utility
Select Restore from the Utilities menu of the Navigator window. This 
invokes a wizard to help you define the following parameters:

• Type of restore (single site, single system, all sites and systems, or 
disaster recovery)

• Specific backup file and destination directory

• Temporary directory for working files created during the operation

The next screen to appear is a dialog box that summarizes your choices. Click 
OK to start the restore operation, or Cancel to return to the wizard and change 
your options.
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Figure 35
MAT Backup Information dialog box
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Using Alarm Notification
MAT’s Alarm Notification application is an advanced alert system to help
you monitor specified events. This application lets users familiar with 
programming logic and scripting principles define alarm-triggering Simp
Network Management Protocol (SNMP) events.

MAT can filter events that originate from the Meridian 1 and a variety of 
defined network devices. MAT complements and supplements existing 
external alarm management systems with added flexibility, features, and
capacity.

When Alarm Notification is running, all received SNMP events are display
in the Alarm Notification window and compared with programmed rules.
You define the rules in a scripts file according to your phone-system 
requirements.

When specified events trigger alarms, these notifications are displayed i
small Console window within the Alarm Notification window. These 
notifications are retained in memory as well. Also, you can set up the 
application for remote alerts, for example, by email or pager.

You can launch this application by selecting Alarm Notification from the 
Utilities menu of the Navigator window. See the Alarm and Event 
Management with Alarm Notification User Guide for more information.
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Working with the System Window
From the Navigator, double-click the system on which you wish to work and 
the System window for that system appears. See Figure 36.  

Figure 36
System window
MAT Common Services User Guide



Page 84 of 124  Working with the System Window
System window allows you to launch the following applications (some of 
these applications are purchased separately):

• Alarm Banner 

• Events

• System Terminal (Ethernet or PPP)

• System Terminal VT220 (serial)

• Station Administration

• Traffic Analysis

• Call Accounting

• Call Tracking

• ESN Analysis and Reporting Tool

• Maintenance Windows

— Core CPU window

— I/O Ports window

— Network Groups window (not applicable for Option 11C)

— Network Loops window (includes B and D-channels window)

— PE Shelves window (not applicable for Option 11C)

— PE Cards window

— PE Units window
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System Window menus
Detailed descriptions about the functions of each command in the System 
window menus are available by clicking the “Context-sensitive Help” butt
in the toolbar. System window menus consist of:

• File

• View

• Maintenance

• Security

• Window

• Help

Toolbar
The System Window toolbar includes several useful buttons. The function of 
each button in the toolbar appears when you move the mouse over the button. 
See Figure 37.

Figure 37
System window Toolbar
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Using Electronic Data Dump
MAT’s Electronic Data Dump (EDD) is a critical database-update operat
on the Meridian 1 switch. This operation dumps (saves) modified data fr
the switch’s resident memory to database files on the switch’s hard disk
These database files contain the active configuration information for 
phone-system terminals and users.

Synchronizing and securing data
Using MAT’s Station Administration and ESN applications, you can mod
station data, Call Party Name Display (CPND) data, and Electronic Switc
Network (ESN) data. MAT stores these changes in its PC database files.
phone system cannot recognize these changes, however, until you uploa
modified data to the Meridian switch. This operation synchronizes switch
data with current MAT data on the PC.

Updating the switch’s data is a two-step process. The first step is to tran
modified MAT data from the PC to the switch’s resident memory. MAT’s
Station Administration and ESN applications include a Synchronize menu 
for this purpose. The second step is to use MAT’s EDD feature to dump
modified data from the switch’s resident memory to the switch’s hard dis

To secure modified data at the switch, you must dump it to the switch’s h
disk. Optionally, your distributor technician can set up the switch so that 
also dump data to a diskette that you insert in the switch’s floppy drive. Po
interruptions erase all data in resident memory. When power is restored
switch data is automatically restored from its database files on the hard d
Modified data that was not previously dumped to these database files is lo
at the switch. Further, this data may be difficult to isolate in the PC’s MA
applications, since all previously uploaded data shares the same TRN 
(transmitted) status. For these reasons, always perform or schedule data 
dumps after uploading data to the switch.
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Accessing EDD
You can access EDD from the File menu of the System window. The EDD 
selection is called Data Dump. This selection has its own submenu with the 
options Now, Schedule, and View Log.

You can select Now to perform the data dump immediately, Schedule to set 
up the operation to run automatically, or View Log to review status and error 
information from the most recent data dump.

The data-dump operation takes just a few minutes. While modified MAT data 
is being dumped at the switch, status and error information about the data 
dump is actively logged to the PC. Both Now and View Log open the EDD 
Data Dump dialog box for viewing or reviewing, respectively, this status and 
error information. This log is saved to the PC’s hard disk and each data d
overwrites the existing log file.

Note: To access error information, open the Events window after the 
data dump and double-click each error event of interest. This invokes 
help that is specific to each error.

The Schedule option opens the Scheduling dialog box. Here you can sel
when and how often you want to dump data at the switch. It is best to sche
this operation for a time soon after uploading MAT data to the switch. Th
MAT Scheduler sends the job to the Queue Manager at the designated 
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Figure 38
EDD Data Dump dialog box
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Responding to a connection failure
If you are connected to M1 system and that connection fails, a warning 
message appears. See Figure 39. You are given the following options:

• Close all system windows and reconnect to the system

• Leave the system windows open so that you can copy or print any o
of the following information:

— Command results in the System Terminal window or any open 
Maintenance window.

— Alarms or events in the System Event Log.

— Maintenance window objects, such as network loops within the 
Network Loops window.

Note: When you have finished printing the desired information, clos
the system window and reconnect to the system.

• Attempt to reconnect to the system.

Figure 39
Connection Failure dialog
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Using System Terminal
System Terminal helps you perform overlay-based tasks directly through the 
Meridian 1 TTY interface. System Terminal provides online, context 
sensitive help for overlays, prompts, and error messages. System Terminal 
also provides a terminal emulation capability.

There are two versions of System Terminal to support two different 
connection types—Ethernet or PPP and Serial—as follows:

• Overlay Passthru is available on X11 release 22 and later systems 
connected to MAT using Ethernet or PPP. Overlay Passthru only 
supports access to the overlays. 

• VT220 provides similar functions for any Meridian 1 system using ser
connections, as well as terminal emulation for all application module
(such as Meridian Mail). VT220 is discussed in “VT220” on page 10

In release 22 and later switches, you access the overlays using the System 
Terminal (Ethernet or PPP required) and access the application modules via 
VT220. In pre-release 22 switches, you access both the overlays and 
application modules via VT220.
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Launching System Terminal (Ethernet or PPP required)
Once you connect to the system of interest, launch System Terminal by 
selecting System Terminal from the Maintenance menu or toolbar in the 
System window. Enter your system user ID and password in the System 
Login dialog. Figure 40 shows the System Terminal window.

Figure 40
System Terminal window
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The System Terminal window displays all system events as they occur. It also 
gives you direct access to any overlay.

Note 1: For Ethernet or PPP connections, each active System Terminal 
connection requires a pseudo-TTY (PTY) port. PTYs are software-only 
I/O ports. The System Terminal and Maintenance Windows applications 
use these ports to access the overlays.

Note 2:  Ethernet and PPP are available only for X11 Software Release 
22 and above with packages 296 and 243 equipped. 

System Terminal window
The System Terminal window includes the following:

• An Enter Command edit box in which you type overlay commands

• A Command Results list box that displays your interaction with the 
overlays and the results

• Links to online help are available for the following:

— Help on the current overlay

— Help on the current prompt

— Help on the last or selected error message

— One-line description of prompts in the status bar

You use overlays just as you did before MAT 6 was available. The one minor 
difference is that you type into an edit box rather than the last line of the 
screen as with TTY and Terminal Emulation applications. You still use the 
<Enter> key to send the typed-in data (an overlay command or response to a 
prompt).
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Using System Terminal
You can do the following from System Terminal:

• Load an overlay as you normally would on a TTY or Terminal Emulati
application

• Cut or copy system events or overlay command results to the clipbo

• Save or capture the command results to a file

• Get help on a Meridian 1 error message

• Get help on an overlay

• Get help on a prompt

• Monitor system events

Advantages over a TTY
You now have the following advantages over the old TTY:

• You can type in lower case and use the backspace key

• Copy and Paste in the Enter Command box (useful for repeated 
commands with only a TN change)

• Scroll back in the command results

• Copy and Print the command results

• Capture output to a file as well as to the screen

• Save the command results to a file
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Getting help on the current overlay
You can get more help on the currently loaded overlay using the Current 
Overlay command in the Help menu. The help file is organized in a similar 
fashion to the I/O Guide.

Note: The Current Overlay button or menu item is disabled when you 
are not in an overlay.

Example
If you are in overlay 10, you can select Current Overlay from the Help menu, 
and then navigate within help to the CPND prompt sequence. You can click 
on any prompt in the sequence. This displays the help window for that 
prompt—the same as help on Current Prompt.

Getting help on the current prompt
Figure 41 shows an example of the help you can get on an administratio
overlay. You load the overlay and respond to the prompts, one at a time. 
help guides you as you load the overlay and respond to the prompts.

Figure 41
Current prompt help example
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If an overlay is currently loaded, the Status Bar at the bottom of the window 
provides a short description of the current prompt.

If the one-line description is not enough, you can read a full description of the 
prompt in Windows Help. Choose Current Prompt from the Help menu.

Note: Help on the current prompt is disabled if you are not in an 
administration overlay.

To get help on any other prompt choose I/O Navigator from the Help menu.

Getting help on an error message
System Terminal can distinguish error messages from the other text in the 
Command Results list box. The Error Message command in the Help menu 
provides the error description in Windows Help.

You can get help on an error message in the following ways:

• Double-click an error message anywhere in the Command Results.

• Select the Error message command in the Help menu to get help on the
last error message (even if it is scrolled off the screen).

• Select an error message anywhere in the Command Results, then s
the Error message command in the Help menu.

• Select the I/O Navigator from the Help menu.

The error message help window appears when you select the Error message 
command in the Help menu.

Note: You can also get help on Meridian Mail System Error and Eve
Reporting (SEER) messages using the I/O Navigator. 
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System Terminal menus
Detailed descriptions about the functions of each command in the System 
Terminal menus are available by clicking the “Context-sensitive Help” 
button in the toolbar. System Terminal menus consist of:

• File

• Edit

• View

• Help

Toolbar
The System Terminal toolbar offers several useful shortcuts to the menu 
commands. See Figure 42. 

Note: The Find and Find Next icons in the toolbar allow you to search
the Command Results for the text string that you enter in the Find box. 
Find is case-sensitive. The search begins at the current location.

Using the I/O Navigator
The I/O Navigator displays a dialog box that allows you to quickly jump to 
help on any overlay, prompt, command, or error message. Select I/O 
Navigator from the overlay’s Help menu or from the I/O Navigator buttons 
in the appropriate Help files.

Figure 42
System Terminal toolbar

Find Box
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The I/O Navigator allows you to navigate through I/O reference help 
independent of your current context within the overlays. For example, you do 
not need to be logged into a system to look up an error message using the I/O 
Navigator. See Figure 43.

Type the overlay number, error message number, or prompt in the text entry 
field and click OK. Help information for the specified overlay, prompt, or 
error message appears.

Figure 43
I/O Navigator dialog
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The Topics button displays the general reference Help index. See Figure 44.

The Cancel button cancels a search.

Figure 44
Example Help Index for an error message
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Entering an overlay (LD XX) or error code mnemonic (ERR, BUG) takes you 
to the contents page of the appropriate help file. Entering the error code 
(BUG3001) or an LD number and a prompt takes you to the Help topic page.

• If the prompt or error message you specify does not exist, the help se
dialog appears with the nearest match selected.

• If the overlay number or error message type do not exist, a “Help file 
found” information dialog appears.

• The I/O Navigator command can be used from within Help. You do no
need to be connected to a switch.

• There are some combination overlays (for example, one help file 
describes two overlays). You can enter either of the overlay number
These cases are:

— LD 36 and LD 41

— LD 40 and LD 42

— LD 20, LD 21, and LD 22

— LD 84 and LD 85

• Leading zeros are not required in error messages. For example, ent
SCH22 or SCH022 will find the description for SCH0022.

• To look up Meridian Mail System Error and Event Reporting (SEER
messages, enter XXXYY (where XXX is the message class, and YY
the message number—no mnemonic is required). For example, ent
11102.
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VT220
The VT220 application models the VT100/220/320 series of terminals to set 
up communications between your PC and the Meridian 1. With VT220, you 
can connect to the Meridian 1 using a serial, PPP (point to point protocol), or 
Ethernet connection. It supports the transfer of ASCII data during a 
communications session and provides normal TTY and VT220 access to 
overlays that are not supported by the MAT applications

Features
VT220 supports the following features:

• Double-height, double-width, blinking, bold and underlined characte

• Complete graphic character set, including a special font for represen
control characters

• Scrolling regions

• 80 and 132 column modes

• Echo, no echo, local mode and autowrap on/off

• Reverse video characters and reverse video screen

• Cursor types—block, underline, vertical line, or none

• Selectable cursor blink rate

• User-definable Tab stops

• Programmable function keys

• Display control mode

• National character sets
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Accessing VT220
Before accessing VT220, you must first select the type of terminal emulation 
session you require. To do so, perform the following steps:

1 Click once on the system name in the MAT Navigator to highlight it and 
click Properties from the File drop-down menu (or simply right-click on 
the system name and click Properties).

2 From the System Properties window, click the Communications tab 
and select the desired settings file from the Terminal Emulation VT220 
Settings drop-down list box (e.g., MMAIL.INI).

3 Click the Applications tab and click once on System Terminal 
(VT220) in the Applications list box to highlight it.

4 Select a communications profile for System Terminal (VT220) by 
clicking on the desired profile name in the Communications Profile 
drop-down list box.

5 Click OK to select these settings and return to the MAT Navigator.

To access VT220, perform the following steps:

1 From the MAT Navigator, select the desired site and system and click 
System Terminal from the Maintenance drop-down menu.

2 From the System Terminal Selection dialog which appears, click 
Serial (VT220) and click OK.
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VT220 will attempt to connect to the terminal based on the communications 
criteria entered in the System Properties Serial Communications Profile for 
this system. Once it establishes this connection, the VT220 main window will 
appear listing the commands and graphical tools required for the emulation 
session. See Figure 45. 

The following sections will briefly list the main functions of VT220.

Figure 45
VT220 window
MAT Common Services User Guide



Page 104 of 124  Using System Terminal

b). 
File menu
The File menu contains functions used to save the VT220 configuration, print 
the contents of the terminal window, record and replay VT220 terminal 
emulation sessions and close the system.

The following is a summary of these functions:

• Save Configuration

• Save Configuration As

• Print

• Print Setup

• Printer Fonts

• Capture

• Playback

• Close

The Save Configuration and Save Configuration As menu items are only 
available if you have selected a user defined terminal type (as defined as the 
‘Other’ VT220 type from the MAT System Properties Communications ta
Otherwise, they will appear grayed.

Edit menu
The Edit menu contains editing commands used to manipulate the text 
appearing in the main window.

The following is a summary of these functions:

• Copy

• Paste

• Select All
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Configuration menu
Once you start VT220 from the system window of the MAT Navigator with 
a user defined type of terminal (as defined as the Other VT220 type from the 
MAT System Properties Communications tab), then you can use the 
Configuration functions to customize the VT220 settings to suit your needs. 
The purpose of having the ‘Other’ type is to allow you to create multiple typ
of settings based on generic settings.

If you do not select ‘Other’ or a user defined type, then you will not requ
these functions to run VT220. The Configuration command will therefore
appear grayed.

Before you can customize the VT220 settings, you must first select the 
custom VT220 settings file OTHER.INI using the Communications tab fro
the MAT Navigator System Properties application. Refer to “Accessing 
VT220” on page 102 for more details on selecting this option. This file 
appears in the VT220 settings drop-down list box. When you launch VT2
from this customizable terminal, you can then use the commands which
appear in the Configuration drop-down menu to change the settings for 
VT220.

Once you have edited the VT220 settings using these functions, you mu
then save the customized configuration file using the Save Configuration As 
command. Using this command, you can enter the name of this configura
file for use in later sessions.

VT220 includes a number of setting files which are predefined depending
the system to which you are connected. For example, M1.INI is a predef
setting file used for a VT220 terminal emulation session with the Meridian
and MMAIL.INI is a predefined setting file for Meridian Mail. These settin
files provide the required VT220 settings and cannot be edited.
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The following is a summary of the Configuration functions:

• Terminal Setup

• National Replacement Character Set

• Map Keyboard

• Program Keys

• Tab Setup

• Options

• Status Bar

View menu
The View menu contains toggles to adjust the display of the VT220 window 
as well as hide and display the Tool Bar, Status Bar and Keys Window.

The following is a summary of these toggles:

• Terminal

• Hide/Show Tool Bar

• Hide/Show Status Bar

• Hide/Show Keys Window
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Terminal menu
The Terminal menu contains commands used to connect and disconnect 
VT220 for a temporary communications setup. The Connect and 
Disconnect commands start and stop the terminal emulation. The 
Temporary Communication Setup function temporarily creates a terminal 
emulation session based on customizable connection criteria. This setup is 
only temporary for the current session. When you access VT220 again, it will 
use the criteria defined for this system in the MAT System Configuration 
function.

The following is a summary of these commands:

• Connect

• Disconnect

• Temporary Communication Setup

Help menu
In addition to the standard online help features for VT220, this Help menu 
contains topics which provide help with the Overlay Enhancer and I/O error 
messages.

The following is a summary of these Help items:

• Help Topics

• Current Overlay

• Current Prompt

• Error Message

• I/O Navigator

• About VT220

The Help Topics menu item will display the help topics for VT220 only if 
you have selected a user defined terminal type (as defined as the ‘Othe
VT220 type from the MAT system Properties Communications tab). 
Otherwise, it will display the help topics for the Meridian 1 system.
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The Current Overlay, Current Prompt and Error Message menu items are 
only enabled if you are running a VT220 terminal emulation for the M1.INI 
terminal type and the system is in overlay mode.

The I/O Navigator Help function allows you to obtain information on specific 
error messages.

The Overlay Enhancer is an online context sensitive help function which 
allows you to obtain quick and direct access to overlay information while in 
an active terminal session with the Meridian 1.

The following Overlay Enhancer Help commands appear in the Help 
drop-down menu:

• Current Overlay

• Current Prompt

• Error Message

The Current Overlay and Current Prompt commands are only available if an 
overlay program is loaded and the terminal session is of type ‘Meridian 
‘PPP’, or ‘Ethernet’. Otherwise, they will be disabled and will appear gray
The Error Message command will be available if the terminal session is o
type ‘Meridian 1’, ‘PPP’, or ‘Ethernet’. Otherwise, it will be disabled and wi
appear grayed.

Note: Selecting an error message in the VT220 window is not sufficient 
to access the Overlay Enhancer help. Unlike the Overlay Passthru 
application which displays online help when you double-click the error 
message, the VT220 help requires that you first double-click the error 
message and then click Error Message from the Help drop-down menu. 
This will then display help for the selected error message
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Keyboard mappings
VT220 uses standard keyboard mappings which, when incorporated into a 
terminal session, will match the appropriate VT keys and actions. These 
default mappings, as shown in the following tables, allow you to run a 
terminal emulation session using the appropriate keys on a standard 101 or 
102-key keyboard.

For example, if you are using VT220 to run Meridian Mail, the Meridian Mail 
softkeys (which appear at the bottom of the menus and screens) will 
correspond to the appropriate function keys on your keyboard. The Meridian 
Mail softkeys correspond to the function keys F6 through F10 on a standard 
101 or 102-key keyboard. Therefore, in a Meridian 1 session, you would press 
F6 to select Softkey 1, F7 to select Softkey 2, etc. For more information on 
the Meridian Mail softkeys, refer to the Meridian Mail System Administration 
Guide

The following tables list the keyboard mappings for VT220 on standard 101 
and 102-key keyboards. 
MAT Common Services User Guide



Page 110 of 124  Using System Terminal
   

Table 1 
Keyboard mappings - VT key

VT Key PC Key

PF1 Num Lock

PF2 Numpad Slash

PF3 Numpad Start

PF4 Numpad Minus

Find Insert

Insert Home

Select Delete

Up Arrow Up Arrow

Down Arrow Down Arrow

Left Arrow Left Arrow

Right Arrow Right Arrow

F6 F6

F7 F7

F8 F8

F9 F9

F10 F10

F11 F11

F12 F12

F13 Sys Rq

F14 Scroll Lock

Help F2

Do F3
P0906946 Standard April 2000



 Using System Terminal Page 111 of 124
F17 Ctrl-F7

F18 Ctrl-F8

F19 Ctrl-F9

F20 Ctrl-F10

Table 2 
Keyboard mappings - VT action

VT Key PC Key

Remove Page Up

Next Screen Page Down

Prev Screen End

Hold Screen F1

Compose Unmapped

Delete Backspace

Keypad Command Numpad Plus

Keypad Enter Numpad Enter

Break F5

Long Break Shift-F5

Control Break Ctrl-F5

Print Screen Unmapped

Keypad 0 Numpad 0

Keypad 1 Numpad 1

Table 1  (Continued)
Keyboard mappings - VT key

VT Key PC Key
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Keypad 2 Numpad 2

Keypad 3 Numpad 3

Keypad 4 Numpad 4

Keypad 5 Numpad 5

Keypad 6 Numpad 6

Keypad 7 Numpad 7

Keypad 8 Numpad 8

Keypad 9 Numpad 9

Keypad Minus Ctrl-Numpad Minus

Keypad Period Numpad Del

Table 3 
Keyboard mappings - VT action scroll

VT Key PC Key

Scroll Left Ctrl-Left Arrow

Scroll Right Ctrl-Right Arrow

Scroll Up Ctrl-Up Arrow

Scroll Down Ctrl-Down Arrow

Table 2  (Continued)
Keyboard mappings - VT action

VT Key PC Key
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Using PC Event Log
The PC Event log displays recent MAT activities and events generated on the 
PC. The PC Event log displays active events in a way that lets you quickly 
view the most important events. 

Using the PC Event window
Once you open the PC Event window, you can perform the following tasks:

— Locate an alarm in the Event file to identify the cause of the prob

— Learn more detail about an alarm

Launching and using the PC Event window
From the Maintenance menu of the Navigator window, select PC Events. 
The PC Event window provides a list of events and a menu bar from which 
you can learn more about the events.

Figure 46
PC Event window
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Filter toolbar checkboxes
Use the Filter toolbar to select the types of events that you wish to display in 
the list. Figure 47 shows the Filter toolbar. Click to check (or uncheck) an 
item. For example, you would check “Critical” to restrict the list to events th
are critical. The Filter Toolbar may be dragged to the top or bottom of th
window. 

Learning more detail about an event
You can learn more about a selected event by choosing Properties in the File 
menu or clicking the Properties button in the popup menu.

Figure 47
Filter toolbar

Figure 48
PC Event Properties sheet
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Appendix A: Script File Summary
This appendix contains a list of all of the script files used for the MAT 
applications. A script is a pre-written program which contains a set of 
commands and functions required to perform specific activities. Some scripts 
are defined for specific PC and Meridian 1 configurations and are therefore 
selected based on each user’s configuration. Most MAT scripts, however
defined for the general operation of the MAT applications and are theref
automatically selected to perform specific functions within MAT.

Common Services scripts
The following script files are used by the MAT Common Services 
applications. They are automatically selected whenever you run MAT an
apply to all of the MAT applications as a whole. You do not need to sele
these script files to perform a required function.

HAYESMDM.SCR Functional script used by Common Services 
applications (except for Call Accounting and 
Call Tracking) for connection with Hayes 
compatible modems

CUSTMDM.SCR Functional script used by Common Services 
applications (except for Call Accounting and 
Call Tracking) for connection with customized 
modems

DSMODEM.SCR Functional script used by Call Accounting for 
connection with customized modems

M1MODEM.SCR Functional support script used to access 
far-end equipment (e.g., dispatcher modems)

ERROR.SCR Functional script required for error handling
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Traffic Analysis scripts
The script files used by MAT Traffic Analysis provide the main functions 
required for traffic data collection and report generation. The data collection 
script files are selected when you enter your Meridian 1 and communications 
parameters. The report generation script files are automatically selected when 
you generate reports.

Real time traffic data collection
The following script files are used for real time traffic data collection (no 
buffer unit). They will be automatically selected when you set up this site for 
real time traffic data collection (from the MAT Site Configuration 
application).

Traffic data collection from MDR-2000
The following script files are used for traffic data collection from an 
MDR-2000 buffer unit. They will be automatically selected when you set up 
this site for traffic data collection through the MDR-2000 buffer unit (from 
the MAT Site Configuration application).

Traffic data collection from PollCat II/III
The following script file is used for traffic data collection from the PollCat 
II/III buffer units. It will be automatically selected when you set up this site 
for traffic data collection using the PollCat II/III buffer units (from the MAT 
Site Configuration application).

LD2.SCR Main traffic data collection scripts

LD2INI.SCR Functional script used by LD2.SCR (used to 
initialize Meridian 1 to have collection 
performed hourly)

LOGSL1.SCR Functional script used by LD2.SCR

M2K.SCR Main traffic data collection script

M2KINI.SCR Functional script used by M2K.SCR (used to 
initialize Meridian 1 to have collection 
performed hourly in pass-through mode)

POLL.SCR Main traffic data collection script
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Traffic data collection from AT1/AT2
The following script files are used for traffic data collection from the AT1 and 
AT2 buffer units. They will be automatically selected when you set up this 
site for traffic data collection using the AT1 or AT2 buffer units (from the 
MAT Site Configuration application).

Traffic data collection from SEB II
The following script file is used for traffic data collection from the SEB II 
buffer unit. It will be automatically selected when you set up this site for 
traffic data collection using the SEB II buffer unit (From the MAT Site 
Configuration application).

Traffic data collection from Sentinel 2000
The following script file is used for traffic data collection from the Sentinel 
2000 buffer unit. It will be automatically selected when you set up this site for 
traffic data collection using the Sentinel 2000 buffer unit (from the MAT Site 
Configuration application).

Traffic Analysis report generation
The following script files are used for report generation. They are 
automatically selected when you generate Traffic Analysis reports.

TSB1.SCR Main traffic data collection script for AT1 
buffer unit

TSB2.SCR Main traffic data collection script for AT2 
buffer unit

SEBTRAF.SCR Main traffic data collection script

SNLTRAF.SCR Main traffic data collection script

AUXPLK.SCR AVGSOA.SCR CALPRK.SCR CBKQUE.SCR

CONSOL.SCR CSAML1.SCR CSAML2.SCR CSAML3.SCR

CSAML4.SCR CSAML5.SCR CSAML6.SCR CSAMLI.SCR

CSAMLK.SCR CUSCON.SCR DCHANL.SCR DTDLAY.SCR

DTNSPD.SCR FEAKEY.SCR GLOBAL.SCR GLPTRF.SCR

GMSGAP.SCR GNTLPS.SCR GOHQUE.SCR GPCLTB.SCR

GPROCL.SCR GROUTL.SCR GSUTRF.SCR GTRNKS.SCR

ICONSL.SCR IMTCHL.SCR INPMSG.SCR INTRKG.SCR
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The following script files are used for the Data Parser as part of the report 
generation process. They are automatically selected when processing data for 
Traffic Analysis reports.

ISDNPD.SCR ISDNPM.SCR ISDNPT.SCR JCTRAF.SCR

JCTRGP.SCR LPTRAF.SCR MICRO.SCR MSGATQ.SCR

MUSBRD.SCR NCOSVC.SCR NETLPS.SCR NETWKS.SCR

NTATSV.SCR OHKOVT.SCR OHKQUE.SCR OMTCHL.SCR

OUTMSG.SCR PCTLTB.SCR PRADIO.SCR PROCLD.SCR

RADPAG.SCR RANBRD.SCR RTLREQ.SCR SELTRM.SCR

SLTRAF.SCR SRADIO.SCR SUMCCO.SCR SUMICO.SCR

SUMSYS.SCR SUMTRK.SCR SVCLPS.SCR TMESSG.SCR

TRUNKS.SCR TSETST.SCR WATCON.SCR WPRCLD.SCR

WTRNKS.SCR

TFC000.SCR TFC001.SCR TFC002.SCR TFC003.SCR

TFC004.SCR TFC005.SCR TFC006.SCR TFC007.SCR

TFC008.SCR TFC009.SCR TFC10X.SCR TFC101.SCR

TFC105.SCR TFN001.SCR TFN002.SCR TFN101.SCR

TFS000.SCR TFS001.SCR TFS002.SCR TFS003.SCR

TFS004.SCR TFS005.SCR TFS007.SCR TFS008.SCR

TFS009.SCR TFS010.SCR TFS011.SCR TFS012.SCR

TFS013.SCR TFS50X.SCR TFS101.SCR TFS102.SCR

TFS105.SCR TFS41X.SCR TRAFFIC.SCR TRFAXS.SCR

TRFCDR.SCR TRFCUS.SCR TRFNET.SCR TRFSYS.SCR
P0906946 Standard April 2000



Appendix A: Script File Summary Page 119 of 124
Call Accounting and Call Tracking scripts
The following script files are used by Call Accounting and Call Tracking to 
perform data collection and real time monitoring. Certain script files are 
automatically selected when you enter your configuration parameters in the 
MAT Site Configuration application. These represent the common scripts for 
data collection. As you define the SDI values in MAT Site Configuration, the 
appropriate script will be selected to match that option. When you then select 
an SDI value from the Call Accounting or Call Tracking Communications 
Database function, each defined script will be selected accordingly.

For example, if you define SDI1 to have real time CDR data collection 
performed from it, then SDI1 will be configured to run the real time CDR data 
collection scripts SL1.SCR and SL1LOGIN.SCR.

Call Accounting may require CDR data which is output from the Meridian 1 
in different formats. In these cases, you must select None as the SDI value in 
the MAT Site Configuration function and then select the desired script file 
from the Communications Database function of Call Accounting.

Note: If you are collecting New format CDR data, then this option must 
be activated on the Meridian 1.

If you collect CDR data from a data file (e.g., if you select the File option 
from the Call Accounting or Call Tracking Communications Database), then 
you can select the filename from which you will collect the CDR data and 
then select a script filename for that particular format of CDR data. For 
example, if you select a file for data collection which contains normalized 
CDR data, then you would select the script file COLLECT.SCR.
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Real time CDR data collection
The following script files are used for real time CDR data collection from the 
Meridian 1; no buffer unit is required.

CDR data collection from MDR-2000
The following script files are used for data collection from an MDR-2000 
buffer unit.

SL1.SCR Real time data collection script for Old format 
CDR

SL1NEW.SCR Real time data collection script for New 
format CDR

SL1NEWX.SCR Real time data collection script for New 
format CDR; supports X11 Release 23

SL1EURO.SCR Real time data collection script for New 
format CDR with Periodic Pulse Metering

SL1EUROX.SCR Real time data collection script for “New” 
format CDR with Periodic Pulse Metering; 
supports X11 Release 23

SL1LOGIN.SCR Functional script used by above-mentioned 
data collection scripts

COLLECT.SCR Data collection script which collects Old 
format CDR from MDR-2000 to produce 
normalized CDR (erases contents of buffer)

COLLECTX.SCR Data collection script which collects New 
format CDR from MDR-2000 to produce 
normalized CDR (erases contents of buffer); 
MDR-2000 requires a chip which is 
compatible with X11 Release 23

2000FD.SCR Data collection script which monitors in real 
time Old format CDR from an MDR-2000

2000FDX.SCR Data collection script which monitors in real 
time New format CDR from an MDR-2000; 
MDR-2000 requires a chip which is 
compatible with X11 Release 23
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CDR data collection from PollCat II/III
The following script files are used for data collection from the PollCat II/III 
buffer units.

CDR data collection from AT1/AT2
The following script files are used for data collection from the AT1 and AT2 
buffer units.

CDR data collection from SEB II
The following script files are used for data collection from the SEB II buffer 
unit.

POLLCDR.SCR CDR data collection script for PollCat II/III 
buffer units

PARSESL1.SCR Functional script used by POLLCDR.SCR

POLLNEWX.SCR CDR data collection script for PollCat II/III 
buffer units; supports X11 Release 23

NEWCDRX.SCR Functional script used by POLLNEWX.SCR

AT1CDR.SCR CDR data collection script for AT1 buffer unit

AT2CDR.SCR CDR data collection script for AT2 buffer unit

PARSESL1.SCR Functional script used by AT1CDR.SCR and 
AT2CDR.SCR script files

AT1NEWX.SCR New format CDR data collection script for 
AT1 buffer unit; supports X11 Release 23

AT2NEWX.SCR New format CDR data collection script for 
AT2 buffer unit; supports X11 Release 23

NEWCDRX.SCR Functional script used by AT1NEWX.SCR 
and AT2NEWX.SCR script files

SEB.SCR CDR data collection script for SEB II buffer 
unit

PARSESL1.SCR Functional script used by SEB.SCR script file

SEBNEWX.SCR New format CDR data collection script for 
SEB II buffer unit; supports X11 Release 23

NEWCDRX.SCR Functional script used by SEBNEWX.SCR 
script file
MAT Common Services User Guide



Page 122 of 124 Appendix A: Script File Summary
CDR data collection from Sentinel 2000
The following script files are used for data collection from a Sentinel 2000 
buffer unit.

Call Tracking alarm scripts
The following script files are used for Call Tracking alarms. They will be 
automatically selected when you define the Call Tracking alarms.

CDR data collection modem scripts
The following script files are supporting function scripts used by all CDR 
data collection scripts for Call Accounting and Call Tracking. The 
appropriate script will be automatically used when you select Hayes or 
Custom as the format for the modem for CDR data collection from the MAT 
Site Configuration application.

If you enter custom modem information when setting up a site, then the 
custom modem script file will be updated with the appropriate parameters.

SNLCDR.SCR CDR data collection script for Sentinel 2000 
buffer unit

SNLCDRX.SCR CDR data collection script for Sentinel 2000 
buffer unit; supports X11 Release 23

CMALARM.SCR Call Tracking alarm script

CMPAGER.SCR Call Tracking alarm pager script

HAYES.SCR Functional script used by all CDR data 
collection scripts in Call Accounting and Call 
Tracking for connection with Hayes 
compatible modems

CUSTOM.SCR Functional script used by all CDR data 
collection scripts in Call Accounting and Call 
Tracking for connection with customized 
modems (updated with correct parameters)
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Script usage table
The following table lists the types of scripts which would be selected for 
different scenarios for Call Accounting and Call Tracking. These represent 
the main scripts which can be selected to suit a particular scenario. All other 
scripts will automatically selected depending on these script selections.

Table A-1
Script usage table

To Use

Perform real time CDR data collection from 
Meridian 1

SL1.SCR

Collect CDR from MDR-2000 buffer unit COLLECT.SCR

Collect CDR from PollCat II/III buffer units POLLCDR.SCR

Collect CDR from AT1 buffer unit AT1CDR.SCR

Collect CDR from AT2 buffer unit AT2CDR.SCR

Collect CDR from SEB II buffer unit SEB.SCR

Collect Traffic data from SEB II buffer unit SEBTRAF.SCR

Collect CDR from Sentinel 2000 buffer unit SNLCDR.SCR
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